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Nicht mal die Entwickler von Screaming Frog (SF) wissen genau, wie viele verschiedene 
Metriken sich mit ihrem beliebten Crawler-Tool beobachten lassen. Ein Versuch des 

Autors, sie zu zählen, wurde beim Überschreiten von 300 abgebrochen (mitgerechnet 
wurden die Metriken, die sowohl nativ als auch durch die APIs gesammelt werden). 
Da ist also offenbar eine ganze Menge mehr zu holen, als man gemeinhin vermutet.

Evgeniy Orlov hat für Sie recherchiert und ausprobiert, 

» wie sich die Metriken von SF und der angeschlossenen  
APIs automatisch monitoren lassen,

» wie sich die Monitoringdaten in der Form von Time-Series-Charts  
in Google Data Studio (GDS) darstellen lassen und

» wie man das automatische Update des  
Google-Data-Studio-Berichts aufgesetzt.

Wer dem Step-by-step-Beitrag aufmerksam folgt, erhält am Ende einen 
Google-Data-Studio-Report, der als Datenquelle regelmäßige automatisierte SF-Crawls 
hat! Somit kann man jederzeit auf aktuelle und individuell angereicherte Kenndaten 

einer Website zugreifen.

AUTOMATISIERTES 
MONITORING MIT 

SCREAMING FROG 
UND GOOGLE DATA STUDIO
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Abb. 1: Ein einfacher Datenfluss: von SF zu Google Sheets, von Google Sheets ins Archiv, aus dem Archiv in GDS

Neue SF-Funktionalitäten 
erlauben jetzt nützliche 
Automatisierungen 

Durch einige der letzten Updates 

von Screaming Frog (SF) wurden wich-

tige neue Funktionen implementiert 

und diese lassen sich nun bestens zur 

Automatisierung ansonsten aufwen-

diger manueller Prozesse nutzen. Die 

wesentlichen Erweiterungen sind: 

	» Der SF kann jetzt Exporte von zeit-

gesteuerten automatisierten Crawls 

auch in Google Sheets speichern.

	» Beim Überschreiben der alten Daten 

mit den neueren Daten in demselben 

Google-Sheets-Dokument wird die ID 

des Dokuments beibehalten. Anfangs 

war diese Funktionalität gar nicht 

offensichtlich – erst nach eingehen-

den Tests stellte sich heraus, dass 

nur mit der Beibehaltung ein und 

derselben Dokument-ID tatsächlich 

weitere Aktionen möglich sind.

	» Die Datenansicht „internal_all“ 

bekam eine Datumspalte spen-

diert, wo das Datum des Crawls als 

„Crawl_timestamp“ eingetragen wird. 

Diese Funktionalität war ebenfalls 

zu Anfang nicht gegeben – in einem 

Workaround war es nötig, zusätzlich 

HTTP Header zu crawlen, um das 

Datum des Zugriffes bestimmen zu 

können. Denn genau dieses Datum ist 

die ausschlaggebende Metrik bei der 

Erstellung von Time-Series-Charts in 

Google Data Studio (GDS)!

Der Datenfluss im Überblick
Zum Überblick, wie die vom SF 

gecrawlten Daten am Ende im GDS lan-

den, wird im Folgenden zunächst kurz 

der Ablauf beschrieben: 

	» Der SF crawlt alle notwendigen Met-

riken und legt sie in einem Tab eines 

Google-Sheets-Dokuments ab.

	» Wie bereits erwähnt, würde norma-

lerweise der SF die Daten von heute 

am nächsten Tag mit den neuen 

Daten einfach überschreiben. Des-

halb müssen die aktuellen Daten 

jeweils in einem anderen Tab archi-

viert werden. Die Überschreibung 

der Daten ist übrigens die einzige für 

die Automatisierung passende Ein-

stellung in SF. Die zweite vorhandene 

Einstellung ist, dass der SF für jeden 

Crawl einen Ordner mit dem Crawld-

atum als Ordnernamen erstellt und 

dort die Datendatei ablegt.

	» In „Archiv“-Tabs sind somit die Daten 

jedes Crawls sauber nacheinander 

gespeichert. 

	» Beim Erstellen des GDS-Berichts wird 

als Datenquelle dann der Archiv-Tab 

angegeben.

Nötige Vorbereitungen für 
die Crawl-Einstellungen

PageSpeed API-Schlüssel 
erstellen

Als Beispiel für das Berichtsmonito-

ring wird hier exemplarisch die Metrik 

Time to First Byte (weiter TTFB) genom-

men. TTFB, die Zeit bis zum ersten 

Byte, ist eine Ladezeit-Metrik, die zeigt, 

wie schnell der Server auf eine Anfrage 

reagiert. Diese Metrik erhält der SF 

durch die Abfrage der PageSpeed 

Insights (weiter PSI) API. 

Dazu muss allerdings erst ein sog. 

API-Schlüssel für PageSpeed Insights 

API erstellt werden, sofern man als Ent-

wickler darüber nicht bereits verfügt. 

Wie man an diesen Schlüssel kommt, 

beschreibt Google recht anschaulich 

unter http://einfach.st/speedkey in einer 

Anleitung, der man einfach folgt.  

PageSpeed API-Schlüssel 
in den SF eintragen

Ist der Schlüssel erstellt bzw. war 

schon vorhanden, muss er im SF hinter-

legt werden. Unter Configuration -> API 

Access -> PageSpeed Insights findet sich 

ein Eingabefeld, wo man genau dies 

bewerkstelligen kann.

Nachdem der API-Schlüssel dort 

einkopiert wurde (Abbildung 3) klickt 

man auf den Connect-Button und der 

Status wechselt von Rot (not connec-

ted) zu Grün (connected), wie Abbil-

dung 4 zeigt. Unter dem Tab „Metrics“ 

findet man dann ausklappbar alle 

verfügbaren Metriken, die Google für 

eine URL zur Verfügung stellt. Nach 

der Wahl des Endgeräts, also ob man 

Daten für Desktop oder Mobile möchte, 

klickt man dann einfach die Metriken 

an, die man übertragen haben möchte. 

Im vorliegenden Fall ist dies nur „Time 

to First Byte“ in der Rubrik „Lighthouse 

Metrics“ (Abbildung 5). Wer später 

mehr Metriken automatisiert über 

das Google Data Studio überwachen 

möchte, wählt sich an dieser Stelle 

dann die gewünschten Daten per Maus-

klick aus.

AUTOMATISIERTES 
MONITORING MIT 

SCREAMING FROG 
UND GOOGLE DATA STUDIO
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Crawl Mode: 
Als Liste oder als Crawler?

Um die bestmögliche Vergleich-

barkeit und Darstellung zu erreichen, 

eignet sich am besten der Crawl Mode 

„List“. Hier lassen sich immer gleiche 

definierte URLs hinterlegen, die dann 

abgearbeitet werden. Hierzu wählt man 

am besten typische/wichtige Seiten 

der Website aus. Bei der Metrik TTFB 

macht das zwar keinen Unterschied, 

aber wenn man ggf. später auch Metri-

ken holt, welche z. B. vom Aufbau der 

Seite beeinflusst werden, bekommt 

man für jede Kategorie vergleichende 

Werte. Es macht meist wenig Sinn, 

z. B. bei einem Shop Daten für immer 

gleich aussehende 10.000 Produkt-

seiten zu holen. Die werden sich nicht 

nennenswert unterscheiden, daher 

reichen einige URLs zum Messen aus 

dieser Kategorie aus. Weitere wichtige 

Seitentypen bei Shops wären z. B. 

Kategorieseiten, redaktionelle Inhalte, 

die Startseite, Übersichtsseiten oder 

Suchseiten. 

Als abzuarbeitende Liste dient 

eine einfache Textdatei mit einer URL 

je Zeile, eine Excel-Tabelle oder auch 

eine Sitemap. Diese Liste stellt man 

vor dem Crawl bzw. dem Start des SF 

zusammen.

Eine Konfiguration für 
automatische Crawls erstellen

Es ist immer ratsam, für automa-

tisierte Crawls eine eigene Konfigu-

rationsdatei anzulegen. Für das vor-

liegende Beispiel wird der Einfachheit 

halber tatsächlich nur die Lighthouse 

Metric „Time to First Byte“ aktiviert, 

alle anderen Checkboxen müssen deak-

tiviert werden.

Danach wird genau diese Konfi-

guration im SF-Menü unter dem Pfad 

File -> Configuration -> Save as als Datei 

gespeichert. 

Die Konfigurationsdatei hat als 

Dateiendung .seospiderconfig – das ist 

zwar nicht gerade kurz, aber dafür gut 

erkennbar.

Abb. 2: Hier wird der PageSpeed-Key im SF 
hinterlegt

Abb. 5: Anschließend muss man noch das 
Gerät (Desktop, Mobile) und Metriken auswäh-
len, die von der API pro URL gezogen werden 
sollen 

Abb. 6: Der Pfad zur Speicherung der Konfigu-
rationsdatei

Abb. 3: Hier wird der API-Schlüssel einkopiert

Abb. 4: Wenn der API-Schlüssel hinterlegt wurde, kann der SF mit Google verbunden werden

EIN HINWEIS FÜR NUTZER VON 
NOTEBOOKS

Crawls werden nicht starten, solange 
das Notebook nicht mit der Stromlei-
tung verbunden ist. Der Screaming Frog 
klinkt sich in das „Task Scheduling“ von 
Windows ein und so, wie ein Smart-
phone ein Update verweigert, wenn der 
Akku nicht ausreichend geladen ist, so 
ist auch hier der Stromanschluss eine 
eingebaute Sicherheitsmaßnahme, 
dass ein Crawl korrekt ausgeführt wird 
und nicht wegen eines schwachen 
Akkus abbricht.
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Daher ist die Einstellung hier „List“.

Crawl Seed: Hier wird mithilfe des 

Buttons „Browse“ die Datei mit der zu 

crawlenden URL-Liste ausgewählt. Dies 

kann wie bereits erklärt eine einfache 

Text-Datei sein, mit einer URL pro Zeile 

und getrennt mit einem einfachen Zei-

lenumbruch, eine Excel-Datei oder eine 

XML-Sitemap.

Crawl Config: Hier wählt man die 

vorhin abgespeicherte Konfigurations-

datei aus.

Weil der SF beim Crawl hier auf 

die API von Google zugreifen wird, 

muss auch die Checkbox „PageSpeed 

Insights“ ausgewählt werden.

Der Tab „Export“
Beim Klick auf diesen Tab sind 

zunächst fast alle Felder ausgeblendet 

(Abbildung 11). 

Ein automatisierter Crawl startet 

beim SF immer in einem sogenannten 

headless-Modus – in einem eigenen, 

quasi unsichtbaren Prozess ohne eine 

Projekte erstellt, darin Unterordner für 

die Tasks und darin die exportierten 

Datendateien.

Bei Benennung von Projekt und Task 

als „Test Projekt“ und „Test Task“ wird 

in Google Drive die unter Abbildung 9 

ersichtliche Ordnerstruktur erstellt.

Das Datum und die Uhrzeit in der 

letzten Zeile bestimmen, wann der 

erste Crawl starten soll. In der Drop-

down-Liste wird ausgewählt, ob der 

Crawl einmalig, täglich, wöchentlich 

oder monatlich durchzulaufen hat. Um 

schnell die Ergebnisse zu sehen und 

um ggf. detailliert zu dokumentieren, 

wurde in diesem Beispiel „Daily“ aus-

gewählt.

Im Tab „Start Options“ werden 

anschließend die gewünschten Einstel-

lungen für den automatischen Lauf des 

SF hinterlegt. Die folgenden Einstel-

lungen wurden hier für das vorliegende 

Beispiel gewählt: 

Crawler Mode: Wie erwähnt, ist 

es besser, mit einer Liste zu arbeiten. 

Den SF für den  
automatischen Crawl  
vorbereiten

Beim Screaming Frog können regel-

mäßige (scheduled) Crawls unter dem 

Menü File -> Scheduling erstellt werden. 

Sofern bisher noch keine automa-

tischen Crawls gespeichert wurden, 

ist hier noch kein Eintrag vorhanden. 

Ein Klick auf „Add“ öffnet ein weiteres 

Fenster mit drei Tabs, in denen alle 

nötigen Einstellungen vorgenommen 

werden können. 

Der Tab „General“
Hier werden Task-Name und Pro-

ject-Name eingetragen (Abbildung 8): 

Beide Felder bzw. Namen sind wichtig, 

damit die gecrawlten Daten später am 

korrekten Ort in Google Drive landen. 

Beim erstmaligen Speichern der Daten 

in Google Drive erstellt SF von sich 

aus im Root einen Ordner namens 

„Screaming Frog SEO Spider“. In die-

sem Ordner werden Unterordner für 

Abb. 7: Hier werden die Einstellungen für auto-
matische Crawls verwaltet

Abb. 8: Scheduling Set-up, Tab „General“

Abb. 9: GDrive-Ordnerstruktur, internal_all ist die exportierte Datendatei mit den Ergebnissen 
des Crawls
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grafische Benutzeroberfläche. Das 

ist deshalb so, damit automatisierte 

Crawls einer SF-Instanz, die gerade in 

einem „normalen“ Nutzermodus ausge-

führt wird, nicht in die Quere kommen. 

Der SF kann also im Hintergrund auto-

matisch crawlen, während man ihn via 

Oberfläche manuell benutzt.

Nach dem Anklicken der head-

less-Checkbox werden dann auch die 

weiteren Optionen aktiv auswählbar 

(Abbildung 12). 

„Output Folder“ ist hier irrelevant, 

weil der Output direkt in Google Drive 

gespeichert wird. Dafür wurde ja der 

Projekt- und Taskordner dort angelegt.

Die Radioboxen darunter sind sehr 

wichtig: Hier wird eingestellt, was mit 

den Daten passiert, die aus den regel-

mäßigen Crawls hinzukommen. Hier 

muss unbedingt die Option „Overwrite 

files in output“ ausgewählt werden.

Weiter unten findet man eine 

weitere wichtige Einstellung, mit der 

festgelegt wird, welche der unter-

schiedlichen Datenansichten aus dem 

SF exportiert wird. Beim Klick auf den 

Button „Export tabs“ öffnet sich ein 

Pop-up-Fenster. Im linken Teil dieses 

Fensters sind dann alle im SF vor-

handenen Datenansichten aufgelistet. 

Hier wählt man die erste Datenansicht 

„Internal:All“ aus (Abbildung 13).

Beim Klick auf den nach rechts 

zeigenden Pfeil verschiebt sich die aus-

gewählte Datenansicht auf die rechte 

Fensterseite.

Danach kann das Pop-up-Fenster 

wieder geschlossen werden. 

Unter Format findet man weiter 

rechts eine Dropdown-Liste für die 

Auswahl eines Ausgabeformats für die 

Exportdatei. Hier wählt man sinniger-

weise „gsheet“ aus. Anschließend muss 

man dem SF natürlich erlauben, Daten 

auf dem Google Drive zu speichern. 

Beim Klick auf „Manage“ wird daher 

ein Fenster geöffnet, wo man aus den 

bereits vorhandenen bzw. bereits 

benutzten (eigenen) Google-Konten 

Abb. 10: Die Startoptionen im Überblick

Abb. 11: Tab „Export“ – alle Optionen bis auf headless sind deaktiviert

Abb. 12: Tab „Export“ – jetzt sind alle Optionen aktiv

Abb. 13: Wichtig ist die Auswahl der Datensicht „Internal:All“
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Add-on „Archive Data“ (ladbar unter 

http://einfach.st/anakravitz), das ziem-

lich genau das gesetzte Ziel erfüllt. Das 

Add-on muss installiert werden – es 

kostet nichts.

Archivierungseinstellungen
Nach der Installation des Add-ons 

von Ana Kravitz wechselt man in die 

Datenansicht. Der Inhalt der Datei sieht 

ungefähr so aus:

	» Spalte A: „Address“, es sind die 

gecrawlten URLs

	» Spalte B: Content Type

	» Spalte C: Status Code

	» Spalte D: Status

Dann folgen viele Spalten mit den 

Spaltenüberschriften von SF, aber ohne 

Inhalte, und weiter rechts, als letzte 

drei Spalten, folgen dann:

	» Time to First Byte mit den gecrawl-

ten Werten

	» URL Encoded Address – noch einmal 

die URLs, und, als letzte Spalte

	» Crawl Timestamp mit dem Datum 

und der Uhrzeit.

Hinweis: Alle folgenden Schritte 
müssen in der exakt beschriebenen 
Reihenfolge ausgeführt werden:
	» Einen neuen Tab erstellen

	» Den neuen Tab als „Archiv1“ umbe-

nennen

	» Im Sheet1 die Zeile 1 mit den Spal-

tenüberschriften kopieren und im 

Archiv 1 in die Zeile 1 einsetzen

	» Archiv-Einstellungen öffnen: Add-ons 

-> Archive Data -> Manage

Data Studio zu werden, noch einige 

Anpassungen erfahren. Darum geht es 

im Folgenden.

Google Sheets: Erstellung 
einer Datenquelle für GDS

In Google Drive liegt nun ein 

Google-Sheets-Dokument, das sich 

nach jedem Crawl aktualisiert bzw. 

ergänzt. Da bewusst nach einer URL-

Liste gecrawlt wird, bleibt die Anzahl 

der Zeilen und Spalten im Sheet 1 

immer gleich.

Damit eine GDS-Datenquelle sich 

für die Erstellung von „Time-Series“-

Charts eignet, müssen im vorliegenden 

Kontext zwei Bedingungen erfüllt sein:

1.	 Jede Datenzeile muss ein Datum 

haben.

2.	 Die Crawl-Daten müssen so archi-

viert werden, dass sie in einem 

anderen Tab immer untereinander 

geschrieben werden, nachdem die 

neuen Daten nach dem jeweils 

nächsten Crawl erscheinen.

Die Bedingung 1 ist erfüllt – wie 

erwähnt, enthält seit Neuestem die SF-

Datenansicht internal_all in jeder Zeile 

das Datum und die Uhrzeit des Crawls 

(Crawl_timestamp), und zwar prakti-

scherweise gleich in einem von Google 

Sheets erkennbaren Format.

Um die Bedingung 2 zu erfüllen, 

sind einige vorbereitende Modifikatio-

nen nötig.

Archive Data: 
Add-on finden und installieren

Ana Kravitz (https://mixedanalytics.

com/) entwickelte ein Google Sheets 

eines auswählen oder auch ein neues 

hinzufügen kann. SF leitet so transpa-

rent durch die Prozedur, dass bei jedem 

Schritt Klarheit über das nötige Vorge-

hen vorhanden ist.

Jetzt ist das Set-up des automati-

schen Crawls abgeschlossen – ein Klick 

auf „OK“ und der Projektname erscheint 

im Fenster mit der Liste aller automati-

schen Crawls.

Nach getaner Arbeit muss im Goo-

gle Drive im entsprechenden Ordner 

eine neue Datei namens „internal_all“ 

erscheinen. Diese Datei muss, um spä-

ter eine passende Datenquelle für das 

Abb. 14: Der Klick-Pfad zu den Archiv-Einstellungen Google Sheets

Abb. 16: Alle Archiv-Einstellungen – vorher

Abb. 15: Die Option „ADD NEW“ erscheint
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box gesetzt ist, erscheint eine Drop-

down-Liste „Run Report“ mit der 

Auswahl, ob die Archivierung täglich, 

wöchentlich oder monatlich ausgeführt 

werden soll. 

Between: Wird „täglich“ gewählt, 

erscheint noch ein Dropdown namens 

„between“, wo die Zeiträume ausge-

wählt werden dürfen, die jeweils eine 

Stunde lang sind. Wird z. B. 9 a. m – 10 

a. m. ausgewählt, so erfolgt die Archi-

vierung im Zeitraum von 9 bis 10 Uhr 

vormittags. 

Name: Hier wird der Name verge-

ben und mit „Save“ gespeichert. Somit 

ist Archivierung korrekt eingestellt und 

abgeschlossen. Abbildung 18 zeigt alle 

vorgenommenen Archiv-Einstellungen 

im Überblick.

Der Tab „Archiv1“ ist nun korrekt 

modifiziert, um als Datenquelle für 

einen GDS-Bericht zu dienen.

Den GDS-Report erstellen

Report aufsetzen
Um den Report für Data Studio auf-

zusetzen, lädt man es zunächst unter 

https://datastudio.google.com. Dort 

erstellt man diesen neuen Report unter 

-> Create -> Report (Abbildung 18).

Anschließend wählt man als 

Connector Google Sheets aus, wie 

Abbildung 19 zeigt. Nun wird ein 

Auswahlscreen angezeigt, wo alle zur 

Verfügung stehenden Google Sheets 

aufgelistet sind. Hier wählt man das 

vorher angelegte Dokument „internal_

all“ aus und dort dann den Archiv-Tab 

„Archiv1“ (Abbildung 20).

Die Auswahl wird dann ganz ein-

fach durch einen Klick auf den Add-

Button unten rechts bestätigt. Nach 

dieser Bestätigung erscheint bereits 

der Report mit der ersten Datentabelle 

(Abbildung 21).

In der rechten Spalte „Available 

Fields“ sind alle Felder aus der Daten-

quelle aufgelistet – bei der Einbindung 

der Datenquelle wurde die Option 

Abbildung 14, Abbildung 15 und 

Abbildung 16 zeigen das weitere Vor-

gehen. Die Seitenleiste rechts mit den 

Archiv-Einstellungen bleibt offen, unab-

hängig davon, in welchem Tab man sich 

befindet.

Select source sheet and range: 
Sinngemäß muss hier der Tab und der 

Bereich ausgewählt werden, der zu 

archivieren ist. Im Tab „Sheet1“ wird 

hierfür der ganze Bereich ausgewählt, 

die die Daten enthält, jedoch nicht 

die Zeile 1 mit den Spaltenüberschrif-

ten. Wenn dieser Bereich z. B. über 

A2:BA70 geht, wählt man ihn aus und 

klickt den Button „Set geklickt“ an – 

Sheet1!B2:BA70 bleibt in dem Feld 

stehen.

Select destination sheet and 
range: Dasselbe muss für den Ort der 

Archivierung gemacht werden – es 

muss im Tab „Archiv1“ der Bereich 

derselben Größe für das Ziel ausge-

wählt werden wie die Quelle. Hierfür 

wird der Bereich A2:BA70 ausgewählt 

und auf den Knopf „Set“ geklickt. 

Archiv1!A2:BA70 bleibt im Feld stehen. 

Archive to: „Rows“ muss ausge-

wählt werden, damit die archivierten 

Daten später untereinander erscheinen.

Paste To Next Empty Range: Ist 

bereits voreingestellt.

Keep Formatting: Hier nichts ankli-

cken.

Schedule Report: Wird verwen-

det, denn die Daten müssen ja immer 

wieder archiviert werden, nachdem im 

Sheet1 die neuen Daten die alten über-

schreiben. 

Run Report: Nachdem die Check-

DIE ZEITEN RICHTIG 
EINSTELLEN!

Der Zeitraum für die Archivierung 
sollte erfahrungsgemäß am besten eine 
Stunde nach dem Crawl eingestellt 
werden. Wurde z. B. der Crawl auf 8 
Uhr vormittags eingestellt, so sollte die 
Archivierung in der Zeit von 9 a. m.–10 
a. m. erfolgen. Also immer erst der 
Crawl, dann erst die Archivierung!

Abb. 17: Alle Archiv-Einstellungen – nachher

Abb. 18: GDS – einen Report erstellen

„Use first row as headers“ ausgewählt. 

Zwar hat die Tabelle viele Spalten mit 

den Überschriften, aber wenig Daten 

– genauer gesagt, nur die für die Dar-

stellung nötigsten.

Entsprechend wird die Visualisie-

rung der beobachteten Metrik zusam-

mengesetzt: auf der X-Achse die Zeit, 

auf der Y-Achse die TTFB-Werte der 

beobachteten URLs.
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 Abb. 19: GDS – Google Sheets als Connector (Datenquelle) auswählen

 Abb. 20: GDS – im Google-Sheets-Dokument den entsprechende Archiv-Tab wählen

 Abb. 21: GDS – die erste automatische Report-Darstellung nach Anbindung der Datenquelle

 Abb. 23: Erstellung des kalkulierten Feldes

Der Inhalt des Reports
Die erste Seite des Reports enthält 

fünf Seiten mit dem schnellsten TTFB-

Werten. Zusätzlich ist ein Dropdown 

eingebaut, um jede Domain mit jeder zu 

vergleichen und den Vergleich grafisch 

darzustellen. Die zweite Seite des 

Reports enthält eine Tabelle mit allen 

Teilnehmern des Monitorings. Sie stellt 

TTFB von heute dar und errechnet den 

prozentualen Unterschied zum Vortag.

Ein kalkuliertes Feld zur
Herauslösung von Domains aus 
den URLs

Zusätzlich wurde in den Report 

ein sog. kalkuliertes Feld (calculated 

field) eingebaut, das aus einer URL eine 

Domain samt TLD-Endung herauslöst – 

sogenannte „naked Domains“ lassen 

sich gut darstellen.

Das kalkulierte Feld lässt sich auf 

folgende Weise erstellen: In der rechten 

Spalte „Available Fields“ ganz unten 

gibt es einen Button „ADD A FIELD“. 

Dieser wird angeklickt und in dem 

neuen Fenster wird Folgendes eingege-

ben. Es wird ein Field-Name vergeben. 

In das Feld „Formula“ wird der reguläre 

Ausdruck eingegeben, der aus einer URL 

die Domain herauslöst. Im aktuellen Fall 

lautet der reguläre Ausdruck wie folgt:

REGEXP_EXTRACT(REGEXP_
EXTRACT(REGEXP_REPLA-
CE(Address, „^(.*//)“, „“), 
„^([̂ /]*)“),R“([̂ \.]*\.[̂ \.]*)$“)

Der reguläre Ausdruck bezieht sich 

auf die Spalte „Address“, in welcher die 

URLs gespeichert sind. Abbildung 22 

zeigt, wie die Erstellung des kalkulierten 

Feldes aussieht.

Zwar lassen sich Domains aus URLs 

noch in Google Sheets mit einer Formel 

herauslösen, in GDS ist die Lösung mit 

dem kalkulierten Feld smarter. 

Der vorkonfigurierte Report steht 

für alle kostenlos unter dem Link http://

einfach.st/froggds2 zu Verfügung. Fragen 

dazu beantwortet der Autor gerne. ¶


